

    
      
          
            
  
Welcome to PAM’s documentation!

PAM is short for PIE Analysis with MATLAB - it is a GUI-based software package
for the analysis of fluorescence experiments and supports a large number of analysis methods.
While originally designed for pulsed-interleaved excitation (PIE, [Müller2005]) experiments, it now has
a wide support for the most commonly used fluorescence experiments.

Currently implemented:


	Fluorescence correlation spectroscopy and its derivatives


	FCS/FCCS/FLCS/fFCS






	Single-molecule FRET spectroscopy (burst analysis), including:


	Photon distribution analysis for two- and three-color FRET experiments


	species-selective filtered fluorescence correlation spectroscopy






	Image correlation spectroscopy, including:


	ICS/RICS/TICS/STICS


	ratser lifetime image correlation spectroscopy (RLICS)


	support for arbitrary region image correlation spectroscopy (ARICS)






	Fluorescence lifetime imaging (PhasorFLIM)


	TCSPC and time-resolved anisotropy analysis






	Getting Started

	PAM - PIE Analysis with MATLAB

	FCSFit

	TauFit

	Microtime Image Analysis (MIA)

	MIAFit

	Phasor Analysis

	BurstBrowser

	PDAFit

	tcPDA

	Particle Detection for Phasor

	Pair Correlation Analysis
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In this part, we try to give a brief step-by-step walkthrough for the installation and usage of the main functions of PAM and its sub-modules.
In most cases, the walkthrough will be based on the example data provided at https://gitlab.com/PAM-PIE/PAM-sampledata.
More advanced methods and settings are explained in other parts of the manual.


Installing PAM

The program can be downloaded from the homepage of Prof. Don C. Lamb - http://www.cup.uni-muenchen.de/pc/lamb/ - or through GitLab - https://gitlab.com/PAM-PIE.

This GitLab group contains four projects:


	PAM: The open-source version of PAM used with MATLAB.


	PAMcompiled: A compiled stand-alone version that does not require MATLAB.


	PAM-sampledata: Some example data the user can use to try out the PAM functionalities.


	PAMdocs: Project that contains files for the developers to update the PAM documentation and manual.





Installing the stand-alone version of PAM


	Verify the correct MATLAB Runtime is installed (currently v9.1/ Matlab 2016b).


You can download the MATLAB Runtime from the MathWorks Web site by navigating to

http://www.mathworks.com/products/compiler/mcr/index.html

For more information about the MATLAB Runtime and the MATLAB Runtime installer, see
Package and Distribute [https://de.mathworks.com/help/compiler_sdk/package.html] in the MATLAB Compiler documentation in the MathWorks Documentation Center.






	Download the compiled version of PAM for your Operating system (MacOS or WIN) from


https://gitlab.com/PAM-PIE/PAMcompiled






	Unpack the files.


	Run the PAM.exe (Windows) or run_PAM.command (MacOS) to start the program. For MacOS, consult the readme.txt and how_to_create_shortcut.txt for additional information.






Installing and updating the open-source version of PAM

The open source version of PAM requires a valid licence for MATLAB (2014b or newer).
Certain features further need access to tool boxes (curve fitting, image processing, optimization, statistics and machine learning, parallel computing) to work.

You can obtain and update PAM either through direct download from Gitlab, using the command line through Git, or by using the MATLAB Git integration.


Downloading from the repository


	Download the open source version of PAM from https://gitlab.com/PAM-PIE/PAM


	Unpack the files.


	Start Matlab and navigate to the PAM folder.


	Type PAM into the Matlab command line to start the program.


	To update, simply download the newest version and overwrite your files.






Using Git


Installing Git

Updating of PAM requires the installation of Git.


	MacOS:


MacOS has Git pre-installed since version 10.9. Try to run git from the terminal. If the command fails, you can download Git from https://git-scm.com.






	Windows:


Download and install Git from https://git-for-windows.github.io.










Downloading and updating using Git


	
	To clone the repository, type git clone https://gitlab.com/PAM-PIE/PAM.git PAM to create a local copy of the repository in the folder PAM.

	
	By default, you are checkout on the branch master, containing the stable version of PAM.


	Should you need the newest updates, switch to the develop branch by typing git checkout develop.


	To switch back, type git checkout master.










	To update, simply type git pull to obtain the newest changes. Note that this will only update the branch that you are currently on.







Via MATLAB Git Integration

To use all features of the MATLAB Git integration, it is recommended to install Git as described above.


	Create a folder for PAM.


	Start Matlab and navigate to the PAM folder.


	Right click the ‘Current Folder’ panel in Matlab and select ‘Source Control’ and ‘Manage Files…’.


	Set the ‘Source control integration’ to ‘Git’ and enter for the ‘Repository path’ https://gitlab.com/PAM-PIE/PAM.git.


	Click ‘Retrieve’ to download the files automatically.


	To update the PAM Git repository to the latest version, simply type !git pull into the MATLAB command line.




To update, you can alternatively use the MATLAB Git integration, however the !git pull method is easier and quicker.


	Right click the ‘Current Folder’ panel in Matlab and select ‘Source Control’ and ‘Fetch’.


	Right click the ‘Current Folder’ panel in Matlab and select ‘Source Control’ and ‘Manage Branches’.


	
	Select the current branch form the remote repository, called ‘origin’.

	If you work on branch master, select origin/master (or refs/remotes/origin/master).







	Click ‘Merge’ to merge the changes from the remote into you local repository.







Modification and development of PAM

Users are encouraged to modify the code of PAM for their individual needs
and help with the development of new and the improvement of existing functionalities.

To report bugs or suggest improvements and bugfixes, please use the Issues [https://gitlab.com/PAM-PIE/PAM/issue] function of GitLab.
For this, a free GitLab account is required.

To contribute to PAM, please consult the contribution guide [https://gitlab.com/PAM-PIE/PAM/blob/master/CONTRIBUTING.md].




Where to find the sample data

The sample data is provided at https://gitlab.com/PAM-PIE/PAM-sampledata, including profiles for the different setups.
Copy the profile files (.mat) into the /profiles folder of your PAM installation and restart PAM to make them available.



Setting up PAM

PAM is designed as a program running in the MATLAB environment.
The used functionalities require a licensed MATLAB version 2014b or later and several toolboxes (optimization, statistics and imaging).
A compiled standalone version that does not require a MATLAB installation will be available, but with limited functionalities especially for data export and custom plotting, since no access to the raw data is available via global variables.
To install PAM, simply download the .zip file and extract it. Open MATLAB and navigate to the PAM folder. It is advised not to add the PAM folder to the Matlab path, as this might create confusion later on when using concurrent PAM versions.
Here, type PAM into the command window to start PAM, or type the name of a sub-programs to start the particular window directly. Alternatively, right-click the respective .m file and select Run.


Setting up a Profile

All settings in PAM are defined in a user profile that can be selected in the Profiles list in the top-left corner of the Profiles tab in PAM.
A minimal starting profile is automatically created, if none exists.
How to create a new profile is described for the example of a two-color PIE microscope with individual detectors and B&H SPC150 TCSPC cards for green and red. The sample data is found in the /SetUp folder.


[image: _images/Profiles.png]

Overview of the Profile and Settings configured for the example explained below.



Right click the Profiles list and select Add new profile to create a new profile.

A popup will open asking for a name for the profile. Click Ok once you typed in the name.

Click on the new profile in the Profile list and press enter or right click and select Select profile.

The new profile now only has one detector channel. In our case, we need a second channel for the red detector.

Alternative 1: Right click on the Detector list and select Add new microtime channel.
We now have to set the Det# value of the second channel to 2, corresponding to our second TCSPC card.

Alternative 2: PAM has an automatic channel detection feature.
When data is loaded that is not associated with an existing channel, a new channel will be created automatically.
To turn this feature off/on, right click the Detector list and select Auto-detect used detectors and routing

Load the data set atto532_atto655_m1.spc from the /SetUp folder using the Multi-card B&H SPC files recorded with B&H-Software routine.

You can change the color and name associated with the channels as you like (e.g. Green and Red).

To display the microtime histogram of both channels, we adjust the Microtime tabs and Plots per tab properties in the Settings tab.
In this case, we set the Plots per tab to two. Now, the histograms are shown in the Microtimes tab.

Now, we need to define PIE channels. Most calculations and functions of PAM are based on these PIE channels.

Initially, a single PIE channel associated with the first detector channel is created. In our example, we need to create two more.
For this, right click the PIE channel list and select PIE channel and Add new PIE channel.

For the two-color PIE setup, we need one PIE channel for the green detection after green excitation (GG), one for red detection after red excitation (RR) and a third for red detection after green excitation (GR).
The last combination possible PIE channel of green detection after red excitation (RG) does not contain useful signal and can be neglected.

Set the associated detector channel of the GR and RR channels to the red detector and GG to the green.

The microtime ranges associated with each laser depend heavily on each individual setup.
In this case we assume that the green laser pulse arrives in the first half of the microtime range and the red in the second half. The total range is 4096 TCSPC channels.

Set the range for the GG and GR channels  to 1-2048 and the RR channel to 2049-4096.

You can also change the color associated with each channel by right clicking the PIE channel list and selecting PIE channel -> Change channel color, or via the c key.

The different PIE channels should now also be indicated in the microtime histograms as colored backgrounds. Make sure that they overlap with the corresponding decays.




FCS and FCCS


Performing FCS calculations

To perform FCS and FCCS calculations, first load your data. You can also load multiple files at once. The data will then be concatenated and treated as a single, longer measurement.

In this case, we will show how to perform correlations based on the atto532_atto655 B&H .spc example data.
For this, select the FRET-FCS profile. Here, we have a total of 4 detectors, for green parallel, green perpendicular, red parallel and red perpendicular.

First load the data. For this, you need to select the _m1.spc format (B&H multi-card format).

To select on which particular PIE channels you want to perform the auto- and cross-correlation, use the checkbox table in the Correlate tab.
The diagonal elements represent the auto-correlations. The others correspond to the cross-correlation of the row and the column PIE channels.

For this example, we will calculate the auto-correlation for the green and the red channels plus the cross-correlation between them.

For the auto-correlations we will correlate GG1 with GG2 and RR1 with RR2.
By calculating the correlation from signal of two different detectors and TCSPC cards, we can remove correlation artifacts from detector afterpulsing and TCSPC dead time.
This is especially noticeable at very short delay times (~100ns).
Since the dyes are freely rotating, any polarization effects can be neglected in this case.

For the cross-correlation, we will use the combined channels to improve the photon statistics.
For green, this is the GG1+GG2 PIE channel.
For red, we will use the RR1+RR2 channel.
We can also do a cross-correlation between the green channel and the full red channel (GR1+GR2+RR1+RR2).
This represents the case of not using PIE.


[image: _images/fcs_pie_channels.png]

The PIE channels defined for the FCS measurement. Top to bottom: GG1, GG2, GR1 and RR1, GR2 and RR2.



Next, select the type of correlation (for standard FCS use Point) and the file type.
The .mcor format is a PAM specific type based on the standard Matlab data format (.mat) and can be easily loaded into Matlab (for plotting etc.).
The .cor format is a simple text file that can be used to look at the data outside of Matlab or PAM.
Both can be analyzed with the FCSFit sub-module.

FCS calculations are done in individual segments, indicated by the gray segments in the intensity trace plot.
You can set either the total number of segments or their length with the Section time or the Section number properties in the Settings tab.

You can remove individual segments from the calculations by simply left clicking on them.
This is useful to remove small artifacts, like aggregates, air-bubbles or dust, from the correlation.

To start the correlation, simply press the Correlate button in the Correlate tab.
The files are saved automatically in the folder of the raw data with the same filename and an added suffix of ‘channelname1_x_channelname2’.

Once the calculation is finished, the correlation curves will be shown in the bottom right plot.
Each selected PIE channel combination is displayed in an individual plot.
The individual curves represent the selected segments.
They can be discarded individually with a left click on the curves.
If you choose to unselect segments at this point, right click the plot and select Save selected correlations to update the file to you new selection.


[image: _images/fcs_preview_plot.png]

The preview plot of the individual segments after the correlation has been performed.



Multiple files can be correlated separately by clicking the Multiple button in the Correlate tab.
A file selection dialog will open and the user can select multiple file to be correlated.
Each selected file is loaded and correlated separately one after another.
The same settings (PIE channels, selected segments, etc.) are used for all of them.

Another way to automatically perform multiple correlations is done using the database functions.



Using FCSFit

FCSFit is the sub-module of PAM for analyzing FCS and FCCS data.
It can be opened via the Advanced Analysis menu in the menu bar of PAM or from the command window by typing in FCSFit.

Here we will show its functions on the case of the data used for the FCS part (atto532_atto655).

Once you opened the window, first load the fit model you want to use. Select File and Load Fit Function.
The last fit model used during the previous session will be preloaded.
For this example, load the FCS_TauD.txt model.
This is a simple diffusion through a 3D gaussian focus model with an added triplet dynamics term.

Next, load the correlation files.
File -> Add Files will add the new files to previously loaded once, while Load New Files will clear the previous entries.

The fit parameters can be adjusted in the Fit parameters table in the Fit tab at the bottom.
The F anf G checkboxes can be used to fix or globally link individual parameters, respectively.

The settings for the fitting procedure can be adjusted in the Settings tab.

Select Start…Fit in the menu bar to begin the fit.

Once the fit is finished, the results will be displayed in the Fit parameters table.


[image: _images/fcs_autocorrelation_fit.png]

Fits to the autocorrelation functions GG1xGG2 and RR1xRR2.



The fit results can be copied to the clipboard with the Copy Results to Clipboard options accessed by right-clicking the Fit parameters table.

The FCS curves and fits can also be exported to a new Matlab figure with a right click on the plot and selecting Export to figure.
The export settings can also found in the Settings tab.


[image: _images/fcs_crosscorrelation_fit.png]

Fits to the cross-correlation functions (GG1+GG2)x(RR1+RR2) - i.e. using PIE, and (GG1+GG2)x(GR1+GR2+RR1+RR2) - i.e. not using PIE. When PIE is not used, the spectral cross-talk of the green dye leads to residual cross-correlation amplitude.






Single-molecule FRET

For this tutorial, use the FRET-FCS-profile and load the sample data DNA_1h using the option Multi-card B&H SPC files recorded with B&H-Software. The data folder additionally contains measurements of the buffer and a pure water sample to measure the instrument response function (IRF) for lifetime fitting. The profile already contains the data from these measurements (background photon counts, IRF pattern), so we do not need to load these data files here. See the section in the PAM manual for a description of how to define these calibrations.


Extracting bursts for single-molecule FRET

The loaded data was recorded using PIE and polarized detection, resulting in for detection channels and a total of 6 PIE channels (GG1, GG2, GR1, GR2, RR1, RR2), which are already set up in the profile.

Switch to the Burst Analysis module in PAM. Select Sliding Time Window as Smoothing Method and APBS 2C-MFD as the Burst Search Method. This will perform an all-photon burst search (APBS), pooling all photons of the individual detection channels into one, using the sliding time window burst search. First, we need to assign PIE channels to the FRET channels used in the burst analysis. FRET channels are denoted by DD for the donor signal after donor excitation, DA for the FRET signal after donor excitation, and AA for the acceptor signal after direct excitation by the acceptor laser, split into parallel and perpendicular polarization. Assign the PIE channel GG1 to DD-parallel, GG2 to DD-perpendicular, GR1 to DA-parallel, GR2 to DA-perpendicular, RR1 to AA-parallel and RR2 to AA-perpendicular. Now, set the burst search parameters as 500 \(\mu\) s for the time window, 100 photons minimum per burst and a threshold of 5 photons per time window (i.e. 10 kHz count rate threshold).

Click the Preview button to see a preview of the burst search. Use the arrow to navigate through the preview plot.


[image: _images/burstsearch_preview.png]

Preview of the burst search.



Press the Do Burst Search button to start the burst search. This will perform the burst search and store the result in a .bur file using the filename of the raw data in a sub-folder with the name of the raw data. After the burst search has been performed, the Do Burst Search button will be green. For a description of how to determine the burstwise fluorescence lifetime and the two channel kernel density estimation filter (2CDE), see the respective section in the PAM manual.



Using Burst Browser

Open BurstBrowser using the menu Advanced Analysis -> BurstBrowser or by typing BurstBrowser in the command-line. Click File -> Load New Burst Data and select the file DNA_1h_m1_APBS_2CMFD.bur in the DNA_1h_m1 subfolder.


[image: _images/burstbrowser_unfiltered.png]

The unprocessed burst analysis result shows two FRET populations.



You can change the plotted parameters using the lists in the top right. The left list selects the parameter for the x-axis, the right parameter for the y-axis. Right-click any parameter to add it to the Cut Table, where you can specify lower and upper bounds to constrain the data selection.

In this case, we want to exclude the donor-only and acceptor-only populations. To do so, set restrict the range for the Stoichiometry in the Cut Table to the interval [0.3,0.9]. This will remove contributions of donor- and acceptor-only molecules to the FRET efficiency histogram completely.


[image: _images/burstbrowser_filtered.png]

Filtered burst data after removal of donor- and acceptor-only molecules through the stoichiometry parameter.



For a more detailed description of the functionalities of BurstBrowser see the manual.




Image Analysis

The key steps of using the image analysis functions of PAM will be explained with the example of the RICS_EGPF.ppf file.
For this, select the RICS profile first.


Exporting image data from PAM

There are two ways to export the image data of the individual PIE channels from PAM.

The first one is to load the data into PAM.

Next, select the PIE channels in the PIE channel list for which you want to export the data.

Right click the list and select Export.. and ..image (as .tiff).

Select the folder in which you want the new image files to be saved.

For each selected PIE channel a separate file will be created with the raw data file name and the PIE channel name as a suffix.

The second way of exporting TIFFs from PAM uses the database functions and is explained here.


[image: _images/Image_Export.png]

Exporting images as TIFF stacks.





Using MIA

MIA is the image analysis module of PAM.
It can be started from PAM via Advanced Analysis or from the command line by typing in Mia.


Loading data into MIA

MIA can use two types of data.

The first uses the image data currently loaded in PAM.

To load this data, use the Load… and …data from PAM functions in MIA.
The PIE channels used for this are defined in the Channels tab with the PIE Channels to load options.

The more common type of data is based of TIFFs.
Generally, MIA can use any type of data that can be converted to TIFFs, either with PAM (explained above) or other programs.

To load new TIFFs, use the Load… and single color TIFFs functions in MIA.

Next, select your desired TIFF files for the first channel and click Open.
When multiple files are selected, they will be simply concatenated.

A new file selection will open up, asking you to select the files for the second channel.
Click Cancel if you only want to analyze single color/channel data.

The data will them be loaded and displayed.


[image: _images/MIA.png]

Single color data loaded into MIA.





Performing image correlations in MIA

To do any type of analysis in MIA, fist load the data.

Select a subregion of the loaded file in the left image plots of MIA.
This can be done with the mouse in the left images or with the edit boxes in the ROI tab.

An advanced region of interest selection can be employed by selecting the Arbitrary region ICS settings in the ROI tab.

The images can then be further adjusted in the Correction tab.
This can be useful, e.g. to remove immobile structures for RICS analysis or bleaching effects for TICS.

For the RICS_EGFP data, select a moving average of 1 Pixel and 3 Frames to be subtracted and add the total mean to keep the mean intensity constant.


[image: _images/MIA_Correction.png]

Standard correction settings for RICS analysis.



This removes the correlation from immobile structures in the cell and also corrects for the slight bleaching.

Now that the images are corrected, you can calculate the image correlation by pressing the Do (R)ICS button.

To save the data, choose a file format before performing the correlation. .miacor is a format based on the Matlab data format and can easily be loaded into the MATLAB workspace at a later point in time.
You can also save the data as TIFFs to look at them with other image analysis programs. Both file formats can be loaded into MIAFit.

With the standard settings, the program creates a MIA folder in the folder of the raw data and saved the correlation files automatically.
For the filename, the program used the original name with a suffix for the correlation channel (ACF1, ACF2 or CCF).
Additionally, a info file is generated that contains the key settings used.

You can activate a manual file naming by unselecting the Use automatic filename checkbox.

You can have a quick look at the correlations in the (R)ICS tab, but the main way of analysis is performed with the sub-module MIAFit.




Using MIAFit

MIAFit can be started from the Advanced Analysis menu in PAM or by typing MIAFit into the matlab command line.

MIAFit works basically the same as Using FCSFit.

The difference is in the way the 2D data is displayed.

You can switch between on-axis view for all files (On-Axis tab) or a full 2D correlation display for a single file (2D Plots);

For the RICS_EGFP file, load the RICS_Simple3D model. Set the pixel size (Px) to 40 nm, the pixel time (P_time) to 11.11 \(\mu s\) and the line time (L_time) to 3.33 ms and fix all these values.
It is generally useful to fix the axial focus size (w_z), because this parameter is often hard to determine with RICS. Set it to 1 \(\mu m\).


[image: _images/MIAFit.png]

MIAFit RICS analysis window.






Phasor approach to FLIM


Calculating lifetime phasor data

How to calculate phasor data from you raw data file is explained for the example of the sample phasor data provided with the download.
The data is based on the PAM simulation file format.

First, switch to the Phasor profile. This profile is configured for a single detector channel and a single PIE channel.

Load a reference file (Phasor_Reference_4ns.sim).
Remember that you have to select the PAM simulation file (.sim) format in the file selection menu.

Go to the Phasor Referencing tab in the Additional tab.

Since this example only has one channel, the correct channel is already selected.
In other cases you might have to first select the correct detector channel from the dropdown menu.
Phasor referencing works directly on the detector channels and is independent of the PIE channels

Define the loaded file as the reference by clicking the Use MI as reference button.
Now, this microtime histogram will be used as the reference file until it is replaced, even across sessions.

Next, load the files you want to use (Phasor_Sample.sim) for the phasor calculations.

Use the Range to use fields to adjust the microtime range used for the calculation to your data.
For example, if you recorded two color PIE data and want to analyze the red lifetime, remove the green cross-talk or FRET part from the range.
The program uses the full microtime range, but sets all values outside of the defined range to zero.
In this case you can use the full range of 1-8192.

Before performing the calculation, set the Ref LT field to the lifetime of your reference (here 4ns) and the TAC field to the duration of the full microtime range (here 40ns).

To calculate the phasor and save the data, click the Calculate Phasor Data button.
Select a path and filename and click Save to save the data.


[image: _images/Phasor_Referencing.png]

Phasor Referencing setup for the provided sample data.





Phasor Analysis

The main features of the phasor analysis sub-module are explained for the example of the sample phasor data provided with the download.

Open the Phasor analysis window from the Advanced Analysis menu in PAM or by typing in Phasor into the MATLAB command line.

Use Load Phasor Data to load files you created with PAM or the one provided with the download (Phasor_Reference_4ns.phr and Phasor_Sample.phr).

The intensity images are now shown to the nine image plots at the left hand side of the window.
The files are also added to the Phasor file list in the bottom right and the phasor histogram is plotted in the top right.

You can (de)activate individual files by selecting them in the Phasor file list and using with the arrow keys or remove them with the del key.
The + key will set the file to inactive, meaning that it will be used for calculating the phasor histogram, but not shown in the image plots.


[image: _images/Phasor.png]

Phasor analysis window of the provided sample data. The first file in the list is shown in red, meaning that it is in the inactive state.



The threshold values remove pixels with intensity below or above the set values from the phasor histogram.
You can change them to see how it affects the histogram.

The other parameters in the Settings tab mainly affect how the data is displayed.

In order to indicate the phasor position in the images, there are two principle ways:

Method 1: Region of interest.

Press and hold the number keys 1-6 and click into the phasor histogram to select a region of interest.
The left mouse button creates a rectangular and the right mouse button a ellipsoid ROI.

The pixels inside this ROI will now be assigned  the color associated with the corresponding ROI

You can change the width of the ellipsoid and the color in the ROI&Fraction tab.


[image: _images/Phasor_ROI.png]

ROI selection for Phasor analysis



Method 2: Position indication.

Press and hold the number keys 0 and click into the phasor histogram to place a line into the phasor histogram.

The pixels will be assigned a color corresponding to the closes point on this line.

You can change the maximal distance from the line and the color-code use in the ROI&Fraction tab.


[image: _images/Phasor_Line_GUI.png]

Line selection for Phasor analysis



Use the mouse wheel to zoom into the phasor histogram and the left mouse button to move the view.

Right click the images to export them.

Double click the phasor histogram to export it to a new figure. The setting for this can be adjusted in the Export Settings tab.
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PAM main gui.




Basic functionalities


Loading data

Load data by choosing File -> Load TCSPC data in the menu bar. Currently, PAM supports most TCSPC data file formats. Becker&Hickl hardware is supported for  cards of type 130, 140, 150, 630 and 830 (.spc files). PicoQuant hardware is supported for the TimeHarp200, TimeHarp260(N/P), PicoHarp and HydraHarp (.ptu, .ht3, .t3r files). For PicoQuant only the T3 data format is supported because of the data handling in PAM, which is based on separated macro- and microtime information. (The T2 format records photon arrival time with maximum TCSPC resolution in one array, which can be reconstructed from the separate macro- and microtime photon streams in software. We don’t recommend to use this file format, since information is lost compared to the T3 format.)

While PAM is primarily designed for TCSPC data, many of its features (e.g. FCS or image fluctuation analysis) also work with certain non-TCSPC counting or pre-binned data.
The way to deal with this type of data is described in more detail in Data structure and Custom file formats.


Standard formats

The following read-in options are always available:


	Single-card B&H SPC files recorded with B&H-Software (.spc):

	This is the general read-in routine for Becker&Hickl (B&H) .spc files. Choose this if you want to load data from a single SPC card.



	Multi-card B&H SPC files recorded with B&H-Software (._m1.spc):

	Use this read-in routine if you are recording data on multiple SPC cards simultaneously. When using multiple SPC cards with the B&H software, the data will be saved in individual files for each card, numbered by the extension _m1.spc, _m2.spc and so forth. Using this read-in routine, select the first .spc file, and all associated files with same name but different number will be loaded.



	PicoQuant universal file format (.ptu):

	PicoQuant’s general time-tagged time-resolved file format, which can be recorded by different hardware. Information about the used hardware is encoded in the file and read out upon loading.



	HydraHarp400 TTTR file (.ht3):

	File format specific to the PicoQuant HydraHarp recorded using the version 2 software.



	TimeHarp200 TTTR file (.t3r):

	File format specific to the TimeHarp200 card from PicoQuant.



	PhotonHDF5 file (.h5):

	Photon HDF5 file as described on http://photon-hdf5.github.io.



	PAM simulation file (.sim):

	Simulated data from PAM’s simulation module.



	PAM photon file (Created by PAM) (.ppf):

	Raw photon data exported from PAM.



	Confocor3 raw files (.raw):

	Raw data files recorded with the Confocor 3 module for Zeiss microscopes.







Custom file formats

The high number of different commercial and custom microscope makes it impossible to accommodate all data and file formats that could be used to analyze data in PAM.
An especially big problem is the vast number of different way to encode scanning markers in the data, even when one of the standard TCSPC formats is used.
Therefore, we designated a spot in the filetype selection for a custom read-in routine.
These routines are stored in the Custom_Read_ins folder in the functions folder and must be matlab function files (.m) of a certain base structure.
One of these read-ins can be selected in the profiles tab in PAM and is stored in the UserValues information.
This way each lab can create and adjust local read-ins.

The read-in function must have the following function name:

function [Suffix, Description] = MyFunction(FileName, Path, Type, PAM_handle)





The input parameters are:

FileName    : A 1 x n cell array containing a string with the filename of each file to be loaded

Path        : A string of the folder path of the files

Type        : The type must always be 10 and is used to encode the custom read-in information in the FileInfo

PAM_handle  : A structure containing all the handles of GUI elements of the PAM main figure. This input does not need to be used in the function, but can be used to query certain setting in PAM.

The output parameters are strings used for the Filterspecs and DialogTitle inputs of the matlab uigetfile function.

The function name should then be followed by a short section like this:

if nargin == 0

    Suffix ='*.mytype';

    Description ='My custom data format (*.mytype)';

    return;

end





This section has the purpose to filter the file selection by a certain file ending and to give a short description of the datatype.
Outside of this section the output parameters are not used anymore.

The last requirement of the custom read-in function is to declare some variables global using:

global TcspcData FileInfo





The rest of the code does not have to follow a certain form and can contain other functions or references to non-matlab based functionalities.
The only requirement is that the global variables TcspcData and FileInfo have a specific form (described in Data structure).




Data structure

Most data in PAM is stored in the memory as global variables to allow the user easy access to extract the data at any point of the analysis. These variables are:


TcspcData

This variable contains the basic photon information. It is a structure with two fields, MT and MI.
Both fields are n x m cell arrays, with n representing the different Tcspc cards or modules used, while m represents the routing information.
These cells are addressed by the Detector channels definition of a profile.

Both MT and MI contain entries in these cells for each detected photon.

MT: The macro-time or time since the start of the experiment in clock ticks, stored as a n x 1 double array.
In most TCSPC devices the ticks are based on a internal or external clock, of which the period is stored in FileInfo.ClockPeriod.
In the case of binned raw data, the clock period should be set to the bin duration and a pseudo-photon entry should be created for each intensity count.

MI: The micro-time or time since last synchronization pulse, stored as a n x 1 uint16 array.
If non-TCSPC data is used, these entries should all be set to 1.



FileInfo

This variable contains all the information about the measurement required to perform proper analysis in PAM.
It is a structure with the following required field:

FileType    : Name of the datatype, needed to determine the correct the read-in routine if the data is to be re-loaded.

Type        : Number defining the read-in routine. For custom read-ins the number is always 10.

FileName    : Cell containing all the filenames as strings.

Path        : Folder path of the loaded files

NumberOfFiles: Represents the number of currently loaded files

MI_Bins     : Number of bines used for the micro-time

ClockPeriod : Define the period of the macro-time ticks

SyncPeriod  : Defines the period between two laser- or synchronization pulses. Usually identical to the ClockPeriod. Currently not used.

TACRange    : Defines the full range of the micro-time. Not always equal to ClockPeriod.

Lines       : Number of line of a frame.

Pixels      : Number of pixels per line.

MeasurementTime : Total time of the measurement in seconds

ImageTimes  : Starting time of each frame in seconds. Has Frames or Frames+1 entries (see ImageStops)

LineTimes   : Starting time of each Line in seconds. Is an array of Frames x Lines or Frames x (Lines+1) (see LineStops)

LastPhoton   : Arrival time of each photon of a file in clock ticks

ScanFreq    : Scanning frequency for line or circular scans.

These fields are always required for PAM to work properly.
When data is loaded that does not contain some of the information (e.g. the imaging parameters), they should be initialized to default parameters in the read-in routine.

If both start and stop signals are used for image data, two additional fields are used:

ImageStops   : End time of each frame in seconds. If ImageStops is defined, both ImageStops and ImageTimes have Frames entries, otherwise ImageTimes has Frames+1 entries.

LineStops    : End time of each line in seconds. If LineStops is defined, both LineStops and LineTimes have Frames x Lines entries, otherwise LineTimes has Frames x (Lines+1) entries.

Additional fields can be created to store information for the user, but they will generally not be used by the program.



PamMeta

This variable contains pre-processed data and other information needed for a fast update of the plots.



UserValues

This variable contains a variety of different settings or other parameters (filepaths, IRF or phasor reference data, etc.) that are not specific to the current file and are stored between sessions.
These data are saved in the profile and reloaded upon restart of the program or a change of the used profile.




Setting up a profile

PAM uses profiles to allow the users to work efficiently with data from different setups and configurations.
A profile saves the settings of a session on the hard disk, so that the main parameters do not need to be re-entered every time.

Profile management is done in the Profiles tab in the tip-left of the PAM window.
To switch to an existing profile, select it in the profiles list and press enter or right click and select Select profile.
To create a new profile, right click the profiles list and select Duplicate selected profile or Add new profile.
This will prompt the user to enter a name for the new profile.
All profiles are stored in the profiles sub-folder of PAM as individual .mat files.
When PAM is started, it checks this folder for the profiles list.
Thus, profiles can be easily copied to and shared between different computers.


Hint

It is recommended to create a profile for each setup configuration to speed-up analysis of regular experiments.


  
    

    FCSFit
    

    
 
  

    
      
          
            
  
FCSFit


Contents


	FCSFit


	Data handling and loading


	Saving the analysis state






	Fitting models and algorithms


	Fit models


	Fitting procedure






	Additional settings and exporting


	Alternate mode for global fitting of FRET efficiency histograms









Fitting of FCS data can be accessed from the PAM main window by clicking on Advanced Analysis -> FCSFit or from the command window by typing in FCSFit.

The upper part of the window is dedicated for displaying the FCS data, fits and corresponding residuals. In the lower part of the window the user can set the fit parameters and other fitting and display settings.
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FCSFit main gui




Data handling and loading

Currently, the program only supports files created with PAM, both based on MATLAB files (.mcor) and text files (.cor).

To load new files, got to File -> Load New Files or File -> Add Files. The former clears previously loaded files and load the new ones, while the later adds new files to the loaded ones. All loaded files are listed in the table and the bottom. Individual files can be removed by clicking on the Remove checkbox in the Plotting Style tab.

The raw correlation data is accessible from the command line via the global variable FCSData, and the fits and other processed parameters are stored in the global variable FCSMeta.


Saving the analysis state

The analysis state can be saved as a session (.fcs file) under File -> Save FCSFit Session. This will save all fitted parameters including global and fixed flags, the loaded model function, all settings and the visualization state (line types, curve colors…). Load a previous session using  File -> Load FCSFit Session.




Fitting models and algorithms

Fitting in FCSFit is not based on hard coded fit models but instead uses models stored in text files (standard .txt). This allows users to easily create new models and modify old ones without having to change the code itself, especially useful for a compiled program.


Fit models

FCSFit uses text based fit models. A simple example of the structure of a model is shown here:
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Example model text file



Each model file consists of four segments. The headers of the segments are needed for the program to recognize the individual parts and should not be modified.


	Model description:

	This part is not used by the program itself but is used as a description for the user to understand the purpose and outline of the fit.



	Parameter definition:

	In this section the different parameters used for the fit are defined and initial values set. The nth parameter is defined by Param(n):, followed by the name of the parameter displayed in FCSFit (do not use spaces in the name as they are used as separators). The next settings in order are the initial value, the lower and the upper limits. At the end you can use g or f to the set the parameter to global or fixed during initialization of the fit. The equal signs and semicolons are essential as the program searches for them as separators between the entries.



	Brightness definition:

	The program uses this part to calculate the molecular brightness. Generally, the brightness is defined as 1/N, but can be more complex for other models. Use standard MATLAB nomenclature to define this function and terminate it with a semicolon.



	Fit function:

	Here the actual function used for fitting is defined. The individual parameters are abbreviated as P(n). Use standard MATLAB nomenclature to define the function. Multiline entries are possible. In such a case use simple line breaks and not the ... used in MATLAB scripts and functions.







Fitting procedure

When starting FCSFit, the model used during the last session is pre-loaded. A different fit function can be selected via File -> Load Fit Function. The standard folder for this is the models sub-folder of PAM.

The file names and the fit parameters defined in the model are shown in the table in the Fit tab.
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The fit table



The different rows correspond to the individual files. The last three rows are used to set parameters for all files, the lower and the upper bounds, in order.

The first column after the filenames is used to (de-)activate individual files to include them in or exclude them from the fitting and displaying procedure. The following column shows the average count rate of the file. For cross-correlation it is the sum of both channels. This is followed by the molecular brightness, calculated from the brightness defined in the model time the count rate. The other columns correspond to the different fit parameters with three columns each. The first is an editbox that contains the actual value. The other two are checkboxes used to either fix a parameter (F) or to globally link it between all files (G).  The very last column represents the \(\chi^2_\textrm{red.}\) of the fit.

For the actual fitting, FCSFit uses the standard MATLAB least-square curve fitting algorithm (lsqcurvefit). Only the data-points displayed in the upper plot (defined in the Settings tab) are used for fitting. When no variables are linked globally, each file is fit individually. The free parameters are used for the fit, while the fixed variables are given to the function as additional data to calculate the functions. For a global fit, the variables and fit-functions are concatenated and a single fit is executed. After the fit is finished, confidence intervals are calculated and the plots and tables updated.




Additional settings and exporting

With the Plotting Style tab the user can change the appearance of the plotted data and fits. The Settings tab contains contains a variety of parameters for fitting and displaying, most notably the time range to be displayed and used for fitting (Borders), whether or not to use weights (Use weights) and other fit related settings. Furthermore, it contains general setting for exporting the curves to a new MATLAB window.

The curves can be exported to a new figure or the data can be exported to the MATLAB command line by right clicking the plot and selecting the appropriate function. Additionally, the Copy Results to Clipboard button copies the fit parameters to the clipboard so they can be parsed into standard programs like excel of origin.



Alternate mode for global fitting of FRET efficiency histograms

FCSFit can also be used to fit FRET efficiency histograms exported from BurstBrowser (see Exporting FRET efficiency histograms). Upon file loading, select “FRET efficiency data from BurstBrowser” to load .his files. Currently, models are available for fitting of normal and \(\beta\)-distributions. Note that the \(\beta\)-distribution is only defined in the interval [0,1].

If Plot errorbars is checked, the data is shown as line plot with error bars. Error bars are determined assuming Poissonian counting statistics for the histogram, i.e. by \(\sigma = \sqrt{N}\) where N is the number of counts. If this option is unchecked, data will be shown as stair plots.

FRET efficiency data can be rebinned by changing the bin size (default bin size: 0.01). Choose an appropriate value depending on the sampling of the FRET efficiency histogram.
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FRET efficiency histogram analysis in FCSFit using Gaussian distributions
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TauFit is the central TCSPC module of PAM, dedicated to the analysis of fluorescence intensity decays and time-resolved anisotropy. The following analysis methods are available:


	Tail fitting of fluorescence decays and time-resolved anisotropy


	Reconvolution fitting of fluorescence decays using:


	Single, bi- or triexponential model


	Distribution of donor-acceptor distances


	Time-resolved anisotropy model






	Simulation of \(\kappa^2\)-distributions from fundamental and residual anisotropies




TauFit integrates with both PAM for ensemble-TCSPC analysis and BurstBrowser for burst-selective sub-ensemble TCSPC analysis of species.
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TauFit’s main GUI.




Data loading


From PAM (ensemble-TCSPC)
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The selection GUI.



TauFit directly accesses the data loaded into PAM via the defined PIE channels. To load fluorescence decay data into TauFit from PAM, choose the PIE channels for the parallel and perpendicular fluorescence signal using the popupmenus and click Load Data. If no polarized detection is used, simply select the same channel twice.



From BurstBrowser (subensemble-TCSPC)

To analyze the fluorescence decay of a species from a burst measurement, you can directly export it from BurstBrowser as described in the respective section in the BurstBrowser manual.



From intermediate file format .decay

PAM allows to export the microtime decays of a raw data file into a processed .dec file as described in the respective section of the PAM manual. To load .dec files, select File -> Load decay data (.dec). Note that this will put TauFit into external data mode, disabling interaction with the currently loaded data in either PAM or BurstBrowser. Close TauFit and open a new instance to re-enable the default mode.




Aligning the data


Main plot


[image: _images/alignment.png]

The main plot shows the raw fluorescence decay data of the selected PIE channels, using red for the parallel channel and blue for the perpendicular channel. The respective instrument response functions (IRF) are plotted as dotted lines. Additionally, the scatter patterns for both channels are indicated as dotted gray lines. If the ignore slider is used, a vertical black line indicates the start point of the data that is consider for the goodness-of-fit calculation.



Alignment sliders
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The alignment sliders.



An important step when fitting fluorescence decays obtained on avalanche photodiodes is the alignment of the channels with respect to each other. The sliders should be used in the proposed order:


	Start: Global start of the data range with respect to the PIE channel range, i.e. a value of 10 omits the first 10 TCSPC bins.


	Length: Total length of the data range.


	Perp Shift: Shift of the perpendicular decay with respect to the parallel decay. Affects both the data and the IRF pattern.


	IRF Length: Length of the IRF pattern to be used for reconvolution fitting.


	IRF Shift: Shift of the IRF pattern with respect to the fluorescence decay.


	Perp IRF Shift: Alignment of the IRF in the perpendicular channel with respect to the parallel channel IRF.


	Scat Shift: Shift of the scatter pattern with respect to the fluorescence decay.


	Perp IRF Shift: Alignment of the scatter pattern in the perpendicular channel with respect to the parallel channel scatter pattern.


	Ignore Length: Can be used to ignore a part of the data range for the calculation of the \(\chi^2_{\textrm{red.}}\), while still using the omitted data range for reconvolution.




Generally, the IRF pattern has to be shifted to accurately fit the data using the reconvolution approach. This is caused by countrate dependent timing shifts of the APDs, since IRF and TCSPC measurement are usually performed at different count rates. It can be difficult to correctly assign the shift of the IRF pattern with respect to the fluorescence decay. The user can instead supply a range of IRF shifts and let TauFit find the optimal value (see the description of the fit table).



Correction factors

For accurate fluorescence lifetime and anisotropy analysis, a few correction factors have to be known. Most important for lifetime analysis is the so-called G-factor, accounting for differences in the detection efficiency \(\eta\) between the parallel and the perpendicular detection channel.


\[G = \frac{\eta_\perp}{\eta_\parallel}\]

G can be determined from the relative intensity levels from a measurement of an uncorrelated light source, i.e. a fluorescent dye with a short rotational correlation time. One can either directly take the ratio of the fluorescence signal at large lag time, or calculate G from the residual anisotropy \(r_\infty\) of the dye measurement (see Time-resolved anisotropy fitting). G is the given by:


\[G = \frac{1-r_\infty}{2r_\infty+1}\]

The button Determine G factor can be used to automatically determine G using the described method. The data range should be selected as described for tail fitting or time-resolved anisotropy analysis using the Ignore Length slider.

Additionally, anisotropy measurements with high numerical aperture objectives are subject to depolarization due to polarization mixing [Koshioka1995]. This causes a decrease of the measured anisotropy and is accounted for by the correction factors \(l_1\) and \(l_2\).




Basic data analysis


Tail fitting
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Tail fitting using a biexponential model function.



For a quick determination of the fluorescence lifetime, a single or biexponential or triexponential tail fit of the fluorescence decay can be performed. The parallel and perpendicular channels should be aligned properly. Additionally, the initial rise of the fluorescence decay should be excluded either by using the Para Start or the Ignore Length slider. The fit result is displayed in the top right corner of the plot.

The fit model is given by:


\[F(\tau) = I_0\left( \sum_{i=1}^{N}\alpha_i e^{-t/\tau_i}\right)+c\]

For fitting, the parallel and perpendicular fluorescence decays are combined such that the anisotropy information is canceled out.


\[D = \left(1-3l_2\right)GI_\parallel(t)+\left(2-3l_1\right)I_\perp(t)\]

Tail fitting uses weighted residuals if specified in the options (Use weighted residuals).


Intensity vs. species fraction in TCSPC

When using multi-exponential fit models to describe TCSPC data, it is important to note that the obtained fractions \(\alpha_i\) give the amplitudes at time t = 0 and are proportional to the number of molecules of the respective lifetime. However, the intensity contribution of a species to the fluorescence decay is proportional to the area of the curve, given by \(A_i = \tau_i \alpha_i\). The average lifetime of a multi-exponential is calculated based on the intensity fractions \(f_i\) given by:


\[f_i = \frac{\alpha_i \tau_i }{\sum_{j} \alpha_j \tau_j}\]

The average lifetime is then given by:


\[\left<\tau\right> = \sum_{i} f_i \tau_i\]

This value is reported in the Status Message box in the bottom right, along with the respective intensity fractions.

On the contrary, the value of:


\[\tau_\textrm{amp.} = \sum_i \alpha_i \tau_i\]

is proportional to the area under the curve and thus the steady-state intensity. See [Lakowicz2007] for more details.




Time-resolved anisotropy fitting
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Time-resolved anisotropy fitting.



Similar to tail fitting of fluorescence decays, the time-resolved anisotropy can be analyzed using basic fitting. The anisotropy decay is calculated using:


\[r(t) = \frac{GI_\parallel(t)-I_\perp(t)}{\left(1-3l_2\right)GI_\parallel(t)+\left(2-3l_1\right)I_\perp(t)}\]

The standard model function is based on the wobbling-in-cone approximation, which assumes that the fluorophore’s rotation is restricted by the attachment to the biomolecule. It is given by:


\[r(t)=\left(r_0-r_\infty\right)e^{-t/\rho}+r_\infty\]

where \(r_0\) is the fundamental anisotropy of the fluorophore, \(\rho\) is the rotational correlation time describing the local motion, and \(r_\infty\) is the residual anisotropy due to the slow rotational movement of the biomolecule on a timescale larger than the fluorescence lifetime. If the rotation of the biomolecule \(\rho_p\) is faster, it can be described by an additional exponential term:


\[r(t)=\left[\left(r_0-r_p\right)e^{-t/\rho_f}+r_p\right]e^{-t/\rho_p}\]

The biexponential fit model is available by right clicking the Fit anisotropy button.

Additionally, a model called “dip-and-rise” can be fitted. This model assumes two independent species with different fluorescence lifetimes and rotational behavior, where each component shows a mono-exponential anisotropy decay and single-component fluorescence lifetime. A “dip-and-rise” behavior is often observed for cyanine dyes, where a change in the rotational freedom is connected to the fluorescence lifetime, an effect known under the name PIFE for protein induced fluorescence enhancement. Generally, steric hindrance limits the cis-trans isomerization rates, resulting in a longer fluorescence lifetime, whereas the sterically free dyes show a short fluorescence lifetime. A superposition of both species will result in the “dip-and-rise” anisotropy decay, since the average anisotropy depends on the relative contributions of the two species. The fast-rotating low-anisotropy species contributes at small lag times, causing the anisotropy to decline fast initially. At longer lag times, mainly the slow-rotating high-anisotropy species contributes to the fluorescence signal, causing the anisotropy to rise again.
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“Dip-and-rise” behaviour of Cy3 labeled sample.



The model function is given by:


\[r(t) = A_1(t)\left[\left(r_0-r_{\infty,1}\right)e^{-t/\rho_1}+r_{\infty,1}\right]+\left(1-A_1(t)\right)\left[\left(r_0-r_{\infty,2}\right)e^{-t/\rho_2}+r_{\infty,2}\right]\]

Here, the amplitude of species 1 \(A_1(t)\) is given by:


\[A_1(t) = \frac{I_{0,1}e^{-t/\tau_1}}{I_{0,1}e^{-t/\tau_1}+I_{0,2}e^{-t/\tau_2}} = \left(1+\frac{I_{0,2}}{I_{0,1}}e^{-t\left(\frac{1}{\tau_2}-\frac{1}{\tau_1}\right)}\right)^{-1}\]

The model assumes identical fundamental anisotropy \(r_0\) for both species. The returned parameter \(F_1\) is the fraction of species 1 given by:


\[F_1 = \frac{I_{0,1}}{I_{0,1}+I_{0,2}}\]




Reconvolution fitting

Reconvolution fitting uses the experimentally obtained instrument response function (IRF) to convolute the model function:


\[D(t) = IRF(t)\ast M(t)\]

Here, \(\ast\) denotes the convolution operation. If polarized detection is used, the anisotropy-free fluorescence decay is constructed as described above. The IRF of the combined channel is then approximated in the same manner.

The Convolution Type can be changed in the Settings tab. Linear convolution performs convolution without periodicity. If the selected PIE channels spans the total available microtime range, i.e. the decay pattern is periodic, circular convolution should be used.


Fit table
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The fit parameter table.



The fit table shows the parameters of the currently selected Fit Method. Initial parameter values and lower and upper boundaries (LB, UB) can be specified here. Additionally, parameters can be fixed.

The IRF Shift parameter is a special case. If it is unfixed, the fit will iterate over a range of IRF shift values given by the specified center value and lower/upper bound, i.e. from Shift-LB:1:Shift+UB, and perform the fit routines at those shift values. The goodness of fit is compared between all fits, and the best fit attempt is returned.



Model parameters

There are several common parameters that are part of all model functions:


	Background:

	Inclusion of a constant background contribution into the fit, i.e. a constant offset c with intensity fraction b:


\[D(t) = (1-b)IRF(t)\ast M(t) + bc\]



	Scatter:

	Inclusion of a scatter contribution S(t) as defined from a buffer measurement with intensity contribution s:


\[D(t) = (1-s)IRF(t)\ast M(t) + sS(t)\]





Generally, one should consider using either a constant background if only uncorrelated background noise is present, or only a scatter microtime pattern from a buffer measurement if there is considerable background contribution from the excitation laser. Alternatively, one can check the Scatter offset = 0 option in the Settings tab, which will remove the constant background contribution to the scatter pattern by substracting a baseline first, in which case both options can be used together.

To describe the fluorescence decay, the following model functions \(M(t)\) are available:


Exponential decays

Identical to the tail fitting models (see Tail fitting), with up to three exponentials available.



Distance distribution

This option fits a Gaussian distance distribution model, given by:


\[M(t) = \int\frac{1}{\sqrt{2\pi}\sigma_R}\exp\left[-\frac{\left(R-R_{DA}\right)^2}{2\sigma_R^2}\right]\times\exp\left[-\frac{t}{\tau_{D,0}}\left(1+\left(\frac{R_0}{R}\right)^6\right)\right]dR\]

A donor only contribution can be included:


\[M'(t) = (1-d)M(t)+d\exp\left(-t/\tau_D\right)\]

This model is used to determine the width of donor-acceptor distance distributions in FRET experiments which arises due to the attachment of fluorophores via flexible linkers. The determined distribution width can be used to determine the static FRET line in presence of linker fluctuations in BurstBrowser (see static FRET line).



Anisotropy models

These model functions fit the parallel and perpendicular intensity decays simultaneously with globally linked parameters.
The model function incorporates both the intensity decay I(t) and the anisotropy decay r(t):


\[ \begin{align}\begin{aligned}M_\parallel(t) = \left[1+(2-3l_1)r(t)\right]I(t)\\M_\perp(t) = \left[1-(1-3l_2)r(t)\right]I(t)\end{aligned}\end{align} \]

Background and scatter contributions are separately applied to the model for the parallel and perpendicular decay. The model functions are then convoluted with the respective channel’s IRF.

For the intensity decay I(t) mono- and biexponential models are available. For the anisotropy, the two models described in Time-resolved anisotropy fitting are available. Here, it is assumed that all molecules show identical behavior.

Additionally, the dip-and-rise model, which describes two species with different lifetimes and different rotational properties, is available as Fit anisotropy (2 exp lifetime with independent anisotropy).
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Fitting using an anisotropy model.



When using an anisotropy model, additionally the experimental and fitted anisotropy will be displayed below the main plot.




Extrapolation of the instrument response function

The experimentally determined instrument response function (IRF) might suffer noise due to low statistics, or
be contaminated by a fluorescent impurity that comprises the ideal IRF pattern. In these cases, it is helpful to
extrapolate the IRF using an appropriate model function. That model function is usually a
gamma distribution, which is given by:


\[\mathrm{Gamma}(x|\alpha,\beta,s,b) = \frac{\beta^\alpha}{\Gamma(\alpha)}(x-s)^{\alpha-1}e^{-\beta (x-s)}+b\]

Here, the gamma distribution is given in the shape-rate parametrization with shape \(\alpha\) and rate \(\beta\), \(\Gamma(\alpha)\) is the complete gamma function, and
\(s\) and \(b\) are parameters accounting for the shift of the IRF pattern and constant background.

The IRF pattern can be fit to the outlined model before the reconvolution fitting procedure is performed. Enable this option
in the Settings tab by checking the Clean up IRF by fitting to Gamma distribution checkbox. The plot below the checkbox is used to
show the result of the fitting procedure, whereby the measured IRF pattern is shown as blue dots, and the fitted model is given as a red line.
The IRF pattern will automatically be fit to the model when the fit is started using the Perform reconvolution fit button.


[image: _images/extrapolate_irf_good.png]

Extrapolation of the IRF using the Gamma distribution.






Simulation of \(\kappa^2\) distributions

When loading species-wise fluorescence decay data from BurstBrowser, additional functionality is available to determine the distribution of \(\kappa^2\) values from the available fundamental anisotropies of the donor and acceptor, as well as residual anisotropies of donor, acceptor, and FRET sensitized acceptor emission [Ivanov2009]. The program reports the average value with standard deviation. Additionally, the accuracy of determined distances (i.e. the deviation from the true distance value if \(\kappa^2 = 2/3\) was assumed) and the precision (i.e. the statistical uncertainty of the determined distance) is reported.


[image: _images/kappa2.png]

Simulated \(\kappa^2\) distribution using \(r_0(D)=0.4\), \(r_0(A)=0.4\), \(r_\infty(D)=0.1\), \(r_\infty(A)=0.1\) and \(r_\infty(DA)=0.05\).





Additional settings and exporting


	Use weighted residuals:

	Tail fitting and reconvolution fitting support the use of weighted residuals. If Use weighted residuals is unchecked, the fit quality will be judged based on the mean squared deviation only.


\[\textrm{Mean squared deviation} = \frac{1}{N-P-1}\sum_i (x_i-f_i)^2\]

Here, \(x_i\) are the data points, \(f_i\) is the model function, \(N\) is the number of data points and \(P\) is the number of fit parameters (i.e. \(N-P-1\) is the number of degrees of freedom). If Use weighted residuals is checked, the error for each data point \(\sigma_i\) will be estimate assuming Poissonian counting statistics, i.e. \(\sigma_i = \sqrt{x_i}\). The reduced chi-squared value \(\chi^2_{\textrm{red.}}\) is the maximum likelihood estimate for Gaussian errors and is defined by:


\[\chi^2_{\textrm{red.}} = \frac{1}{N-P-1}\sum_i \frac{(x_i-f_i)^2}{\sigma_i^2}\]

\(\chi^2_{\textrm{red.}} \approx 1\) indicates a good fit, while \(\chi^2_{\textrm{red.}} >> 1\) means that the model is not sufficient to describe the data. \(\chi^2_{\textrm{red.}} < 1\) is an indication for overfitting, meaning that the complexity of the model should be reduced.

For anisotropy fitting, the usage of weighted residual is not available, since no straight-forward estimate is available for the estimation of the error of the calculated anisotropy.



	Automatic fit update:

	Automatic fitting can be enabled in the Setting tab by checking the Automatic fit checkbox. This will cause the fit to automatically update whenever sliders are changed.



	y-axis scale:

	The y-scaling of the main plot can be changed between linear and logarithmic by right clicking the main plot and selecting Y Logscale.



	x-axis scale:

	The x-scaling of the main plot can be changed between linear and logarithmic by right clicking the main plot and selecting X Logscale.



	Exporting plots:

	Plots can be exported by clicking Export Plot in the right-click menu, which will open the current plot in a new MATLAB figure.



	Exporting data:

	
	The fluorescence decay or anisotropy data can be exported as a .txt file by clicking Export -> Save Data to .txt. This will create a file with ending *_tau.txt or *_aniso.txt, depending on what kind of data is plotted. To compare exported data, click Export… -> Compare Data and select the exported .txt files. This will automatically create a comparison plot. When comparing fluorescence decays, the data will be aligned with respect to the maximum intensity point.


	Alternatively, the currently plotted data can be copied to the clipboard, so it can easily be pasted into other software like Excel or Origin (Export… -> Copy Data to Clipboard).


	TauFit integrates with the filtered-FCS functionality of PAM to generate synthetic microtime patterns. This is supported only when using an anisotropy model. Perform a fit and go to Export… -> Export fitted microtime pattern to export the current fit as .mi file that can be used in filtered-FCS analysis.
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The MIA window can be opened from the PAM main window by clicking on Advanced Analysis -> MIA or from the command window by typing in Mia.

MIA is used for a variety of different image analysis methods, mainly via image correlation techniques.

Sample data for different types of analyses can be found here:
https://gitlab.com/PAM-PIE/PAM-sampledata

An introduction and description of the various techniques can be found in:

Image Correlation Spectroscopy (ICS): [Petersen1993]

Image Cross-Correlation Spectroscopy (ICCS): [Wiseman2000]

Raster Image Correlation Spectroscopy (RICS): [Digman2005] and [Digman2009a]

Spatio-Temporal Image Correlation Spectroscopy (STICS): [Toplak2012]

Image Mean-Square Displacement (iMSD): [DiRienzo2013]

Number & Brigthness (N&B): [Digman2008] and [Digman2009b]

Combination of Pulsed Interleaved Excitation and Fluctuation Imaging (PIE-FI): [Hendrix2013] and [Hendrix2015]

Arbitrary Regions for Image Correlation Spectroscopy (ARICS): [Hendrix2016]

Spectrally resolved RICS: [Schrimpf2018]

Performance evaluation for RICS: [Longfils2019]


[image: _images/main_gui1.png]

MIA main gui




Data loading and handling


[image: _images/Load_Menu.png]

The loading menu



MIA supports different kinds of input data.

Menu Load…

single color TIFFs: A popup window appears to select grayscale TIFF files to be loaded (multiple files will be concatenated). The file selection window will be opened a second time to select the files for the second channel. Press cancel if only one color is needed.

RGB TIFFs: A popup window appears to select RGB TIFF files to be loaded (multiple files will be concatenated). Depending on which menu item is chosen, the RG, RB or GR channels from the TIFF file are loaded.

data from PAM: Accessing the files currently loaded in PAM to generate an image series, using the PIE channels defined in the Channels tab.

weighted TIFFs: For loading lifetime-resolved [Hendrix2013] or spectrally-resolved [Schrimpf2018] data. This works the same as standard TIFF data, but extracts re-scaling parameters from the data to account for the non-integer values saved with an integer file format. RLICS and RSICS TIFFs contain the unfiltered data in the first half and the filtered frames in the second half. This option loads only the filtered frames (the raw data can be loaded with the normal single color TIFFs option).

custom data format: This case depends on the particular format selected. To change the custom read-in to the desired format, go to the Options tab.  and change the Custom Filetype dropdown menu.

If you have analog data, you can click the y axis label in the count rate plot to display the axis in counts instead of absolute photon counts (kHz). Alternatively, you can convert analog to photon counting images or select the analog checkbox on on the Options tab.

All data is stored in the global variable MIAData and can be easily accessed from the MATLAB command line.


Options tab


[image: _images/MIA_options.png]

The options tab



Miscellaneous options related to data loading and conversion prior to any analysis are grouped here.

Ch2 orientation: This option can be used to flip or rotate an image in case e.g. cameras were rotated with respect to each other.

Photon counting: Checking it will display all count rate values in kHz. Unchecking it will display counts in arbitrary units.

Raster scanning: Checking it will display the pixel dwell time and line time on the Image tab and converts pixel counts to kHz when calculating count rates. Unchecking it does not rescale pixel counts when calculating count rates.

Custom filetype: Here, the user can define specialized read-in routines. For Zeiss .czi files, use the Zeiss-CZI option. In the leftmost (rightmost) editbox, define the spectral channels summed into the top (resp. bottom) image channel of Mia. 1:11 means summing up spectral channels 1 to 11. The Show spectrum histogram option can be used to verify in which spectral windows the sample fluoresces.

Z-plane to load (only visible when the Zeiss-CZI option is selected): allows extracting specific planes from a multi-plane .czi file. You can also define a range of z-planes by writing e.g. 1:5 or 1,2,5. To allow correct blockwise RICS analysis of a z-stacks, Mia will automatically adjust the frame range (ROI tab) and Window/Offset on the Correlate tab.

S & Offset: Here, the parameters from [Dalal2008] can be entered to convert analog to photon counting images.




Main Image Tab

The central controls and settings of MIA are found in the Image tab. The two leftmost plots show the mean frame intensity and a photon counting histogram. The green lines correspond to the first and the red to the second channel. The dotted lines represent the data for the full stack, while the solid line represents the selected pixels in the region of interest (ROI) after correction. A mouse click on the y-label toggles different displaying options.

The four images in the center show the full frame (left) and the selected and corrected ROI (right) for the first (upper images) and second (lower images) channels. On the leftmost images, the ROI is drawn via a solid square or rectangle.


[image: _images/image_tab.png]

The image tab




Hint

All images in MIA can be exported as 8bit RGBs with the same contrast as displayed.


	
	Leftmost images:

	
	“left-click”: center ROI


	“ctrl”+”left-drag” or “right-drag”: draw normal ROI


	“shift”+”left-click” or “middle-click”: export image.


	if the ‘Left Image Context Menu’ checkbox on the ROI tab is checked, an arbitrary ROI can be drawn via “right-click” on the image










	
	Rightmost images:

	
	“right-click”: draw AROI popupmenu


	“shift”+”left-click” or “middle-click”: export image


	“right-click” on the rightmost images gives a context menu for manually drawing an arbitrary ROI using “left-drag”










	
	Dual color images or videos:

	
	Can be generated using the “Export” Menu
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Fitting of 2D and 3D correlation data can be accessed from the PAM main window by clicking on Advanced Analysis -> MIAFit or from the command window by typing in MIAFit.

The program work in many ways identical to FCSFit with small differences in displaying the data. The upper part of the window is dedicated for displaying the correlation data, either as 1D on-axis plots for all files, or as a 2D representation for a single file. In the lower part of the window the user can set the fit parameters and other fitting and display settings.


[image: _images/main_gui2.png]

The main GUI of MIAFit.




Data handling and loading data

Currently, the program only supports files created with PAM, both based on MATLAB files (.miacor) and TIFF files with additional information added in an info file. A third type are STICS files (.stcor) that treat the different lags as individual files.

To load new files, got to File -> Load New Files or File -> Add Files. The former clears previously loaded files and load the new ones, while the later adds new files to the loaded ones. All loaded files are listed in the table and the bottom. Individual files can be removed by clicking on the Remove checkbox in the Plotting Style tab. Only one STICS file can be loaded at once and all previous files will be cleared.

The raw correlation data is accessible from the command line via the global variable MIAFitData, and the fits and other processed parameters are stored in the global variable MIAFitMeta.



Fitting models and algorithms

Fitting in MIAFit is not based on hard coded fit models but instead uses models stored in text files (.miafit). This allows users to easily create new models and modify old ones without having to change the code itself, especially useful for a compiled program.


Fit models

MIAFit uses text based fit models. An example of the structure of a model is shown here:


[image: _images/model.png]

An example fit model for MIAFit.



Each model file consists of four segments. The headers of the segments are needed for the program to recognize the individual parts and should not be modified.


	Model description:

	This part is not used by the program itself but is used as a description for the user to understand the purpose and outline of the fit.



	Parameter definition:

	In this section the different parameters used for the fit are defined and initial values set. The nth parameter is defined by Param(n):, followed by the name of the parameter displayed in MIAFit (do not use spaces in the name as they are used as separators). The next settings in order are the initial value, the lower and the upper limits. At the end you can use g or f to the set the parameter to global or fixed during initialization of the fit. The equal signs and semicolons are essential as the program searches for them as separators between the entries.



	Brightness definition:

	The program uses this part to calculate the molecular brightness. Generally, the brightness is defined as 1/N, but can be more complex for other models. Use standard MATLAB nomenclature to define this function and terminate it with a semicolon.



	Fit function:

	Here the actual function used for fitting is defined. The individual parameters are abbreviated as P(n) and the variables are x and y. The additional variable i can be used for 3D correlation data. This value is given by the file number and is mostly used for STICS data. Keep in mind that the first file of .stcor data (i.e. i=1) contains the zero lag correlation. Use standard MATLAB nomenclature to define the function. Multiline entries are possible. In such a case use simple line breaks and not the … used in MATLAB scripts and functions.







Fitting procedure

When starting MIAFit, the model used during the last session is pre-loaded. A different fit function can be selected via File -> Load Fit Function. The standard folder for this is the models sub-folder of PAM.

The file names and the fit parameters defined in the model are shown in the table in the Fit tab.


[image: _images/table1.png]

The fit parameter table of MIAFit.



The different rows correspond to the individual files. The last three rows are used to set parameters for all files, and the lower and the upper bounds, in order.

The first column after the filenames is used to (de-)activate individual files to include them in or exclude them from the fitting and displaying procedure. The following column shows the average count rate of the file. For cross-correlation it is the sum of both channels. This is followed by the molecular brightness, calculated from the brightness defined in the model time the count rate. The other columns correspond to the different fit parameters with three columns each. The first is an editbox that contains the actual value. The other two are checkboxes used to either fix a parameter (F) or to globally link it between all files (G). The very last column represents the \(\chi^2_{\textrm{red.}}\) of the fit.

For the actual fitting, MIAFit uses the standard MATLAB least-square curve fitting algorithm (lsqcurvefit) and linearizes the data. Only the data-points displayed in the upper plot (defined in the Settings tab) are used for fitting. When no variables are linked globally, each file is fit individually. The free parameters are used for the fit, while the fixed variables are given to the function as additional data to calculate the functions. For a global fit, the variables and fit-functions are concatenated and a single fit is executed. After the fit is finished, confidence intervals are calculated and the plots and tables updated. For auto-correlation curves, the (0,0) spatial lag point contains the noise peak. Furthermore, some cameras show strong artifacts for a line correlation. Therefore it is possible to omit either the center point of the whole line from the fitting algorithm in the Settings tab.




Data display

Displaying 2D data is much more complicated that for just a single dimension. MIAFit has therefore two different ways of visualization. The first shows the on-axis correlation of all loaded files with the corresponding error bars, fits and residuals. The left side shows the fast and the right side the slow axis for RICS data. The second display option shows the full correlation as a surface plot for a single file. Next to it, the user can display the fit, the residuals or a combination of both.



Additional setting and exporting

With the Plotting Style tab the user can change the appearance of the plotted data and fits.
The Setting tab contains contains a variety of parameters for fitting and displaying, most notably the time range to be displayed and used for fitting (Borders), whether or not to use weights (Use weights), to omit the center point (Center), the whole y=0 line (Line), a specified number of lines (Points) and other fit related settings.
Please be advised that data in which several points have to be omitted from the fitting might be compromised.
Furthermore, it contains general setting for exporting the curves to a new MATLAB window.
The curves can be exported to a new figure or the data can be exported to the MATLAB command line by right clicking the plot and selecting the appropriate function.
Additionally, the Copy Results to Clipboard button copies the fit parameters to the clipboard so they can be parsed into standard programs like Excel of Origin.
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The phasor analysis window can be opened from the PAM main window by clicking on Advanced Analysis -> Phasor or from the command window by typing in Phasor.

The phasor approach to FLIM uses the Fourier space to analyze lifetime image data in a graphical way without the use of fit models, making it less biased compared to convolution or tail-fitting approaches.
An introduction and description of the approach can be found in [Redfort2005] and [Digman2008].
An example application of the features of the Phasor analysis in PAM is featured in [Schrimpf2016].
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The main gui of Phasor.



The Phasor Analysis window is divided into three main panels:


	
	Phasor Panel:

	Plots phasor histogram of activated files.







	
	Image Panel:

	
	Plots:  Displays up to 9 images


	Single: Larger representation of currently selected file


	Intensity: Plots  for Intensity vs. Frequency/G/S










	
	Setting Panel:

	
	Settings: File list and general display settings


	ROI & Fraction: Display settings for ROIs and Fraction Line


	FRET: Settings for FRET estimator


	Export Setting: Controls for Export properties













General Data handling an plotting


Loading Data

To load new data, click on Load Phasor Data in the menu bar and select the files to be loaded. Currently the program only supports phasor files created with PAM (*.phr). The selected files will be added to the File List in the Settings tab.

Phasor now also supports spectral phasor data with the ending *.phs. Either spectral or lifetime data can be loaded at once. Loading the other type will clear previously loaded files.



Removing Data

To remove files from memory select them in the File List and press the ‘del’-Key.



Plotting multiple intensity images


[image: _images/plot_tab.png]

The Image panel.



A newly loaded file will be automatically plotted in the first empty plot in the Plots tab. Files currently displayed are indicated with a blue font and the number associated with the plot in the File List. To free up plots for other files, press the ‘leftarrow’-Key while the File List is active. This deactivates the selected files, indicated by a white font. Deactivated files will not be plotted and not used for calculating the Phasor histogram. Pressing the ‘+‘-Key will also remove the selected files from being plotted, but will keep them active. Active, but not plotted files are shown in a red font. Use the ‘rightarrow’-Key to assign an unplotted file to a free image plot.



Plotting individual intensity images


[image: _images/single_tab.png]

Plotting a single file.



To look at one individual file at a time in a bigger plot, select the Single tab in the Image Panel. Now, only the first selected file in the File List will be plotted and used to calculate the Phasor histogram, independent of whether it is active or not.



Plotting individual image sub-regions


[image: _images/subregions.png]

Plotting an image subregion.



It is also possible to exclude pixels or regions of the image from the Phasor histogram. To do that, click and hold the middle mouse button in the Single plot. A square region around the cursor will be unselected and excluded when calculating the Phasor histogram (but only when in the Single tab). The size of the excluded region can be adjusted with Selection Size.
To reselect individual regions, press and hold the left mouse button. Double clicking the Single plot will reselect the whole image.
Clicking the left mouse button when all pixels are selected will unselect all pixels.
Unselected regions are shown in inverted RGB colors (corresponding to [1 - R, 1 - G, 1 - B]).



Plotting the phasor center of mass


[image: _images/CoM.png]

Plotting center of mass.



To show the center of mass (CoM) of the individual files in the phasor histogram, select the option in the popupmenu in the bottom of the Settings tab.
When either a pixel and photon weighted CoM display is selected, the program displays a marker indicating the CoM for each file used in the calculation of the phasor histogram.
The calculation takes both the photon thresholds als well as the selected sub-region into account.
To change the marker shape, use the popupmenu next to the CoM Selection.
A right click on the shape menu opens a context menu with further options, like size or color of the marker.
The marker properties will be applied to all files selected in the File List.



Changing image display styles

Intensity images are by default displayed using an autoscaled Gray colormap.
To set the contrast manually, uncheck Use Autoscale in the Settings tab and type in lower and upper counts limits.
Besides Gray, there are three standard Matlab colormaps Jet, Hot and HSV, as well as Black, a colormap that displays the image as black (sometimes useful in combination with ROIs).
The different colormaps also behave differently when ROIs are selected, as is described in chapters 2.2, 2.4 and 2.6.


[image: _images/colormaps.png]

Available colormaps.





Plotting Phasor Histogram


[image: _images/phasor_plot.png]

The phasor plot.



The Phasor histogram is always calculated and plotted automatically. The black dotted line corresponds to the universal circle, highlighting all possible phasors for monoexponential decays.
For spectral phasor data, the universal circle is remove and a circle with radius 1 around the origin is plotted to indicate all possible positions.

Depending on the selected tab in the Image Panel different data is used for calculation:


	Plots: All active files (blue or red font in File List) are used.


	Single: Only selected regions of first selected file in File List are used.


	Intensity: All selected files in File List are used.




In all cases all pixels outside the threshold (set via Threshold min/max) are discarded. Furthermore, values far outside the normal range (g or s <-0.1 or >1.2) are also not plotted. For spectral data this range is instead -1 to 1.
The bin size of the Phasor plot can be adjusted using Phasor resolution. The value determines into how many bins the range 0 to 1 for both g and s is divided. Since the actual range is -0.1 to 1.2, the actual resolution is 1.3 times that value (Caution: The resolution must always be a multiple of 10, otherwise the program generates an error).
As in the case of the images, different colormaps can be selected using Phasor colormap, with Jet as default.



Navigating in the Phasor Plot

If the cursor is inside the Phasor plot, the current position, as well as the lifetimes from Phase and Modulation are displayed on the top.
By holding with the left mouse button and moving the mouse, one can reposition the plot, while the mouse wheel can be used to zoom in and out. The middle mouse button resets the default axis limits.




ROIs, Fraction Line and FRET


Selecting a Region of Interest (ROI)


[image: _images/phasor_selection.png]

Selecting ROIs in the Phasor plot.



It is possible to select and plot up to 6 different ROIs in the Phasor plot at the same time, each with one of two possible ROI shapes.

To select a ROI, press and hold keys 1-6 (Numpad also works). Next, click with the mouse inside the Phasor plot and select a ROI by moving the mouse, while keeping the mouse button pressed. If you use the left mouse button, the ROI will be a rectangle, while the right mouse button selects a roughly ellipsoid region. The diameter of the ellipsoid can be set for each ROI individually in the ROI&Fraction tab with the Size parameter.

There are two ways of unselecting ROIs:
To completely delete a ROI, press and hold the number key and click once in the Phasor plot.
The second method deactivates the ROI, while keeping its position in memory for later use. Clicking with the mouse on the respective ROI Button in the ROI&Fraction tab will toggle the corresponding ROIs. Hereby, left and right mouse buttons correspond to the rectangular and ellipsoid shapes, so that it is possible to keep both rectangular and ellipsoid ROIs.



Displaying ROIs

In the intensity plot, the color of pixels that have a phasor inside a ROI and that have an intensity within the set threshold, is changed to the color of the corresponding ROI. In case of overlapping ROIs, the resulting color is the average of the ROI colors.

The image colormap Gray comprises a special case. Here, the pixel color is the scaled intensity times the RGB values of the ROI color, therefore the brightness corresponds to pixel counts, while the ROI is indicated by the hue.

The line width and style of the ROI lines in the Phasor Plot can be changed in the ROI&Fraction tab with the Width and Style parameters, respectively. To assign a different color, click with the middle mouse button on the ROI Button and select a color from the menu.


[image: _images/image_selection.png]

Displaying phasor ROIs in the intensity images.





Selecting a Fraction Line


[image: _images/phasor_line.png]

Using the fraction line.



Since varying ratios of two components result in straight lines in a phasor plot, it is also possible to visualize these ratios with a straight line. Start selecting a Fraction Line by pressing and holding the ‘0’-Key (Numpad also works). Next, click with the mouse at the start position inside the Phasor plot and moving the mouse to the desired end position, while keeping the mouse button pressed. Clicking the left or right mouse buttons when selecting the Fraction Line will result in the reverse color order (explained in chapter 2.4).
There are two ways of unselecting the Fraction line:
To completely delete it, press and hold the 0-key and click once in the phasor plot.
The second method deactivates the Fraction Line, while keeping its position in memory for later use. Clicking with the mouse on the Fraction Button in the ROI&Fraction tab will toggle it.



Displaying a Fraction Line


[image: _images/image_line.png]

Displaying the fraction line in the image.



After selecting a Fraction Line, pixels in the intensity plots will be color coded according to their position on the line. To be precise, the program determines for each pixel the closest point on the fraction line and assigns them a color corresponding to that point. Points further away than the Fraction Size set in the ROI&Fraction tab are not color coded. The colormap used for Fraction Line can be set with the popupmenu in the ROI&Fraction tab.
The image colormap Gray comprises a special case. Here, the pixel color is the scaled intensity times the RGB values of the Fraction Line color, therefore the brightness corresponds to pixel counts, while the position in the line is indicated by the hue.
The line width and style of the Fraction Line in the Phasor Plot can be changed in the ROI&Fraction tab with the Width and Style parameters, respectively. To assign a different color, click with the middle mouse button on the Fraction Button and select a color from the menu. Note that this color only affects the line plotted in the Phasor Plot, not the intensity images.


Hint

You can use custom colormaps to use for color-coding with the fraction line. To do so, create a colormap array (n x 3 double array of values between 0 and 1) in the matlab workspace and copy the data to the variable Phasor_Colormap. Then, declare Phasor_Colormap as a global variable. In the Phasor window, select Custom for the fraction line colormap. The program will then store the custom colormap for subsequent sessions.
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Data exploration and plotting

Single-molecule FRET data can be interactively explored using BurstBrowser’s main figure (“General” tab). Parameters are selected using
the lists in the “Selection” tab. By default, BurstBrowser plots FRET efficiency vs. Stoichiometry.


[image: _images/MainGUI.png]

BurstBrowser’s main GUI.




Selecting data

To apply cuts to data, right-click the parameter to add it to the cut table. Here, you can set the lower and upper boundaries for the
parameter (“min” and “max”). To temporarily disable the cut, uncheck the “active” checkbox. To remove it completely, click the “delete” checkbox.
You can add any combination of parameters.



Using species


[image: _images/species_list.png]

The Species List



Oftentimes, it is helpful to sort the data into different populations or species, which are to be compared with respect to some parameters.
BurstBrowser offers a convenient way to do so based on a species/subspecies hierarchy. Species are accessed using the “Data Tree” panel.

By default, BurstBrowser creates a single species called “Global Cuts”, with two subspecies (“Subspecies 1/2”), in addition to the top level
tree element showing the filename. You can add species or subspecies by right-clicking an existing species and selecting
“Add Species”, which will add an additional species on the same level. Species are removed by clicking “Remove Species”, and renamed by the menu item “Rename Species”.

The general idea of species is to first apply cuts to the measurement to filter out unwanted molecules (i.e. donor- and acceptor-only molecules,
photobleaching events, multimolecule events), and subsequently refine the selection in terms of species (i.e. low FRET efficiency, high anisotropy, etc.).

The following rules apply:


	A newly generated subspecies inherits from the parent species.


	Cuts applied to a parent species will automatically be applied to all subspecies, meaning:


	New parameters will be added to the subspecies.


	Boundary changes will overwrite boundaries in the subspecies.






	Deleting a parameter from a parent species will remove it from all subspecies.


	Deleting a parameter in a subspecies has no effect on the parent


	Cut boundaries in subspecies can not exceed the boundaries of the parent species.


	The active property is inherited also.




Most functions that can be applied to burst selections can be accessed by right-clicking the species list. Additionally, the species list contains a few buttons in the top right for quick access.
These are, from left to right, shortcuts for adding a species, removing a species, renaming a species, exporting the selected species to TauFit, exporting the selected species to PDAFit, and enabling the multiselection mode to compare data sets (see multiselection).


Manual Cut

Manual Cut is available using the crop symbol or by pressing ctrl+space when the main plot is selected. This will turn the cursor into a crosshair that you can use to drag a rectangular selection on the current plot. The defined boundaries will then be applied to the current selected species.



Arbitrary Region Cut (AR)

Arbitrary Region Cut is available by clicking the free selection button or pressing space. Draw a shape in the main plot encircling the population you want to select and confirm the selection by double-clicking the plot. If instead you want to exclude a species from the selection, right-click the Arbitrary Region Cut button and select Invert Arbitrary Region Cut.

Arbitrary Region Cuts can not be modified after they have been defined. In the Cut Table, they will be abbreviated by AR: *, followed by the parameter pair they have been defined on. The *min and max fields have no effect for AR cuts. Like all cuts, if applied to a parent species, they will be automatically applied to the respective child species.




Storing cuts

If you have a set of cuts that you routinely apply to your data (i.e. to select donor-only molecules, or to remove bleaching artifacts…), you can store the cut state and apply it to newly loaded data. Right-click the Cut Table, select Store in cut database and specify a name for the cut state (e.g Donly). Keep the name simple since it will be converted into a valid MATLAB variable name, i.e. all spaces and special symbols will be removed.

After you have defined the cut, it will be shown in cut database popupmenu. To make use of the defined cut state, you can either apply it to the current species using the paint bucket, which will overwrite any existing cuts on the same parameters in the currently selected species, or add a new species with the stored cuts using the plus symbol.

To remove a cut state from the database, right-click the popupmenu and select Remove Cut from Database. To show which cuts a certain stored cut state has defined, click Displayed Selected Cut from Database in the right-click menu. This will show a window with the cut information, and print it to the command line as well.


Note

Arbitrary Region Cuts are not stored in the cut database and simply ignored when saving a cut state.
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PDAFit GUI




Photon Distribution Analysis (PDA)


General introduction to PDA

Photon distribution analysis (PDA, [Antonik2006] [Nir2006]) is a statistical method to describe the observed shot-noise limited FRET efficiency histograms by means of the underlying distance heterogeneity. PDA explicitly takes the statistics of photon emission and experimental correction factors into account and achieves higher accuracy than a direct analysis of the FRET efficiency histogram. It is especially useful for identifying heterogeneity in the FRET efficiency distribution that exceeds the expected value from shot-noise alone, allowing to quantify how defined a conformational state is.

PDA targets the uncorrected FRET efficiency histogram (also called proximity ratio histogram, PRH), where the proximity ratio is given by:


\[PR = \frac{N_{GR}}{N_{GG}+N_{GR}}\]

The algorithm simulates an expected proximity ratio histogram based on the input distances, correction factors and observed distribution of total photon counts, which accounts for the shot-noise. By variation of the parameters of the distance distribution, one can find the parameters that best describe the data.

Generally, two approaches have been proposed to simulate the proximity ratio histogram. Seidel and coworkers developed an analytical approach to calculate the PRH [Antonik2006], while Weiss and coworkers used Monte Carlo simulations to generate an approximate PRH [Nir2006]. Both approaches are implemented in the software, together with a related approach based on a maximum likelihood estimator.

Generally, the proximity ratio histogram is given by:


\[P\left(PR \in [a,b]\right) = \sum_{\textrm{all }(N, N_{GR})\textrm{ for which }\left(\frac{N_{GR}}{N}\right) \in [a,b]} P(N)P_\epsilon(N_{GR}|N)\]

Here \(P(N)\) is the photon count distribution, i.e. the probability to detect \(N\) photons, and \(P_E(N_{GR}|N)\) is the probability to detect \(N_{GR}\) red photons out of \(N\) total photons, given the apparent FRET efficiency \(\epsilon\), described by a binomial distribution:


\[P_\epsilon(N_{GR}|N) = {{N}\choose{N_{GR}}} \epsilon^{N_{GR}}\left(1-\epsilon\right)^{N-N_{GR}}\]

The apparent transfer efficiency \(\epsilon\) is hereby a function of the correction parameters. Background photon counts are additionally considered as described in the references.



The model function


[image: _images/fit_table.png]

The fit parameter table



PDAFit currently only supports normal distributions of distances with up to 5 states. The model additionally allows the inclusion of a donor-only population, which will behave differently from a low FRET population since no direct excitation of the acceptor dye can occur. Generally, the model function takes the form of:


\[M = (1-F_{donor-only}) PRH\left(\sum_{i=1}^{5} \frac{F_i}{\sqrt{2\pi}\sigma}\exp{-\frac{\left(R-\bar{R_i}\right)^2}{2\sigma^2}}\right) + F_{donor-only} PRH_{donor-only}\]

I.e. the donor-only fraction is equivalent to the total percentage of donor-only molecules, while the species fractions \(F_i\) yield the fractions among the double-labeled molecules.

If no conformational heterogeneity is present in the sample and the broadening of the distance distribution is solely due to photophysical artifacts, the observed distribution width \(\sigma\) is proportional to the center distance \(R\) [Kalinin2010b]. Select the Fix Sigma at Fraction of R checkbox in the Settings tab to activate the constraint \(\sigma = f*R\), where \(f\) is the fraction. You can either leave the fraction as a fit parameter or fix it by checking the Fix checkbox next to the edit box.



Generating PDA data

For efficient calculations, PDA requires the data to be of equal time length. Thus, instead of performing the analysis on burst-wise data, the individual bursts are sectioned with a constant time window (typically 1 ms). As a consequence, the obtained proximity ratio histogram in PDAFit may look slightly differently from the histogram in BurstBrowser.

The process of exporting data from BurstBrowser for use in PDAFit is described here.



The correction parameters
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The parameter table



The correction factors used in PDAFit mostly resemble the correction used in BurstBrowser (see correction factors there). If corrections have been applied in BurstBrowser, these are transferred to PDAFit. You can inspect the correction factors in the Parameters tab.

An exception to this rule is the direct excitation factor. In burst analysis, this correction factor is based on the signal in the direct acceptor excitation channel and thus dependent on the acceptor laser power. However, PDA requires the probability of direct acceptor excitation by the donor excitation laser \(p_{de}\), which is given by:


\[p_{de} = \frac{\epsilon_{A}^{\lambda^{ex}_D}}{\epsilon_{D}^{\lambda^{ex}_D}+\epsilon_{A}^{\lambda^{ex}_D}}\]

Here, \(\epsilon_{D/A}^{\lambda^{ex}_D}\) is the extinction coefficient of the donor or acceptor at the excitation wavelength of the donor fluorophore. This quantity has to be determined for each dye pair and is not accessible from the burst data.

In addition to the correction factors, the bin size of the loaded PDA file is given Bin [ms]. This parameter can not be modified. To change the bin size, export the data again from BurstBrowser with a different time bin.

When working with multiple files, you can use the All row to change the respective parameter for all files.


Note

The calculated histogram library is dependent on the set correction factors. A change in any of the parameters will trigger a recalculation of the histogram library, which can be time consuming. Set the parameters correctly in the beginning to save time.
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tcPDA (three-color photon distribution analysis) is the module for quantitative
analysis of three-color FRET data to extract the underlying distance distributions,
similar to the PDAFit module for two-color FRET data. It implements the algorithms
described in [Barth2018].
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The main GUI of tcPDA




Data loading


From BurstBrowser

To process and export burst data from the BurstBrowser module to tcPDA, use the PDA export functionality in BurstBrowser. Load data (.tcpda files) by clicking on the folder icon in the top left.



From text file

As an alternative to the MATLAB-based .tcpda file format, it is also possible to load
text-based data into the tcPDA program. The text-based file format is a comma-separated file
containing the time bin size in milliseconds and a list of the photon counts per time bin for
all detection channels \(N_{BB}, N_{BG}, N_{BR}, N_{GG}, N_{GR}\).

The basic structure of the text-based file format with ending .txt is given by
the following template.

# place for comments
timebin = 1; # timebin in ms
NBB, NBG, NBR, NGG, NGR
46,54,16,95,28
35,60,17,113,46
38,58,14,82,33
67,51,10,94,23
20,32,6,36,13
32,35,9,46,23
7,37,20,50,14
...
...





As before, load it using the folder icon in the top left, and select “Text-based tcPDA file” in the file dialog.




Fitting data


[image: _images/fit_gui.png]

Left: The Fit Table tab contains options for the fit routine and model functions. Right: The Corrections tab allows to set the correction factors.




Defining the correction factors

The correction factors can be set in the Corrections tab. If data has been exported
from the BurstBrowser module, the values for crosstalk (ct), gamma-factors (gamma), Förster radii (R0) and
background counts in kHz (BG) will be automatically transferred to tcPDA and need not be set. However, the value for
the direct excitation probabilities (de) is different in tcPDA compared to the intensity-based corrections to
photon counts in BurstBrowser (see also the respective section in the manual for PDAFit). The direct excitation probability of dye \(X\) after excitation by laser \(Y\), where \(X,Y \in \{B,G,R\}\), is denoted by \(p_{de}^{XY}\) (called de in the GUI). It is defined based on the extinction coefficients \(\varepsilon_X^{\lambda_Y}\):


\[p_{de}^{XY} = \frac{\varepsilon_X^{\lambda_Y}}{\sum_{i=B,G,R}\varepsilon_i^{\lambda_Y}}\]

The other parameters in the Corrections tab are explained in the further sections.



The fit parameter table

The fit parameter table allows to set the initial values for the parameters. It adapts to the selected number of species, whereby the color of the Amplitude parameter indicates the color of the species in the plots. Check the F option to fix parameters. Lower and upper boundaries (LB and UB) are by default set to 0 and infinity, but can be specified if needed. The other columns are related to the usage of prior information and are described in the respective section.


Note

The amplitudes are normalized by the fit routine, i.e. \(\sum_i A_i = 1\). To reduce the number of free fit parameters, the amplitude of the first species is fixed by default, but can be unfixed by the user.
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Particle Detection for Phasor

This module is designed to detect particles or other regions (e.g. cells) and pool all pixels for the individual regions for better signal-to-noise.
As this module is currently in a very early development stage, its shape and functions are changing rapidly.
Therefore, it will be explained only very briefly at this moment.

The program requires framewise phasor data from PAM (.phf files) that are loaded and displayed.

At this moment, a threshold and a wavelet based detection algorithms are implemented.

This algorithms use the intensity information of the file itself or alternatively an external mask (e.g. a second color channel), based on TIFF data, to detect the regions.

The data is then saved as a single, summed up image  with an averaged phasor for all pixels of an individual region.
The phasors of the pixels not assigned can be either saved normally or set to zero.

Alternatively, the data can be saved as a trace for each particle. Hereby, an image is created, where the x-axis corresponds to the frame and the y-axis to the particle number.

Both types of data are saves as .phr files to be analysed the the phasor module.
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The pair correlation analysis window can be opened from the PAM main window by clicking on Advanced Analysis -> PCF Analysis or from the command window by typing in PCFAnalysis.

The pair correlation method ([Digman2009]) extracts information about the spatial behavior of molecular movement using rapid line-scanning and a correlation function between pairs of spatial locations in the sample.
It is especially useful to measure (spatially and directionally resolved) diffusion and transport of molecules across barriers.

The PCF Analysis window is divided into two main parts. On the left side the PCF carpet is displayed and the user can select regions and extract individual correlation curves. The right side is reserved for display of the individual correlation curves that can be averaged and exported.


[image: _images/main_gui3.png]

The main GUI of PCF analysis.




Data handling and loading data

Currently, the program only supports files created with PAM with the file ending .pcor. These files are based on standard .mat files and can also be accessed in the MATLAB command window.

To load new files, got to Load PCF files and select either Load New File or Add Files. Load New File removes previously loaded files, while Add Files adds the new one to the old ones. The currently selected file can be selected with a popupmenu. The loaded data are stored in the global variable PCFData.



PCF Carpet display


[image: _images/carpet.png]

Displaying the pair correlation carpet.



Pair correlation data is a 4 dimensional matrix (position, time lag, distance lag, and backwards and forwards correlation). This makes it very hard to properly display the data in a meaningful way. In this program a carpet for a single distance lag is displayed, with the laser position (=spatial bin) as the horizontal axis and the time lags (as a quasi-logarithmic scale) as the vertical axis. The correlation amplitude is colorcoded using the Jet colormap.

The user can select the displayed spatial lag with the Dist editbox and slider. Furthermore, the editboxes for Points restrict the temporal lags displayed, useful to remove artifacts at early or late time points. Initially, the average of the forward and backwards correlation is plotted (to increase S/N). In cases where diffusion might be direction dependent, the user can select to only display and analyze the forward or backward correlations with a popupmenu.

Right clicking the carpet gives the user additional options:


	Normalize: Normalizes the carpet to the maximal value for each spatial bin. Selecting it again replots the original data.


	Plot: This option allows the user to switch between the correlation, an intensity or an arrival time carpet.


	Export: This exports the currently plotted carpet to a new MATLAB figure.




Below the carpet is a plot displaying the mean intensity profile of the scanned region. With a right click the user can switch to the mean arrival time profile.


[image: _images/intensity.png]

Intensity profile.





Selection of bins and ROIs

In most cases not all bins of the carpet are of particular interest for further analysis (e.g. parts outside of a scanned cell) or the bins need to be sorted into different categories.

Individual bins can be unselected with the green boxes directly below the intensity profile plot. A right click unselects a single bin (indicated by a red box). Note that each spatial bin is part of two correlation curves and both are omitted. A second click selects it again. The left mouse button toggles the selection for all bins at once.
All further analysis and averaging require the definition of regions of interest (ROIs). ROIs can be generated in several different ways:
* Generate ROIs Button: Clicking this button will select a ROI for each consecutive stretch of active bins. That means that if all bins are active a single ROI spanning the full range will be selected.
* Left Click in the Intensity Profile: Left clicking and dragging the mouse in the intensity profile plot selects the area as a single ROI (even across inactive bins)
* Left Click in the Carpet: Left clicking and dragging the mouse in the carpet also selects a ROI. However, due to the spatial lag, this will generate a larger ROI, since it has to include both spatial bins used for the correlation.

The individual ROIs are shown in a listbox at the bottom left. They can be repositioned using the arrow keys and resized with the ´+´ and ´-´ keys. The standard color of a ROI is green. Selecting them and pressing the c key allows the user to select a new color.



Curve extraction and averaging


[image: _images/options.png]

Settings for curve extraction and averaging.



Once the ROIs are defined, the user has to extract the relevant bins either as individual or averaged correlation curves to the correlation curve part on the right side of the window. Hereby, the program distinguishes between two different types of curves:


	Both spatial bins of a particular correlation curve are situated within a single ROI. This case is called “inside�? and these curves can be extracted with the Individual inside button as an entry for each single one or as a single averaged curve with the Averaged inside button or the enter/return key. The individual curves get a random color while the averaged curve has the average color of the ROIs.


	When the first and second bins of a correlation curve are situated in two different ROIs, the case is called “across�?. This requires that at least two ROIs are selected. These curves can be extracted with the Individual across button as an entry for each single one or as a single averaged curve with the Averaged across button or the enter/return key. The individual curves get a random color while the averaged curve has the inverse of the average color of the ROIs (1-RGB).






Individual curve display and exporting


[image: _images/correlations.png]

Correlation curve display and exporting.



The individual and averaged curves extracted from the ROIs are displayed and listed on the right side of the program.

The arrow keys can toggle the display of the selected curves. A further averaging of the curves can be achieved by selecting them and pressing the ´+´ key.

Pressing enter/return will export each selected curve as a .mcor file that can be loaded and fit with the FCSFit program.



[Digman2009]
Digman, M.A. Imaging barriers to diffusion by pair correlation functions. Biophys. J. 97(2), 665-673, (2009).
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Glossary


	APBS

	All photon burst search



	DCBS

	Dual channel burst search



	MFD

	Multiparameter fluorescence detection, i.e. the simultaneous detection of color, fluorescence lifetime and anisotropy information



	PIE

	Pulsed interleaved excitation



	TAC

	Time-to-amplitude converter as used in TCSPC electronics.



	TAC channel

	Unit of the microtime. Related to microtime in nanoseconds by the resolution of the TCSPC electronics.



	TAC range

	The length of the available microtime range, usually given by the inverse of the laser repetition or synchronization rate.



	TCSPC

	Time-correlated single photon counting



	TTTR

	Time-tagged time-resolved data. PicoQuant’s name for TCSPC data.
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Particle Viewer for Phasor

This module is designed to view particle tracking data generated by ParticleDetection.

The program requires particle tracking data from ParticleDetection (.phr files) and can optionally use framewise phasor data from PAM (.phf files).

Currently, the program supports viewing track overlays on the original image data, plotting intensity and lifetime data of each track, and exporting both the overlay image and the data plots for each track.

The program also supports basic background correction by a framewise subtraction of the average intensity surrounding the particle region. It can also fill gaps in the tracking data through linear interpolation of adjacent particle positions. Both of these functions require the appropriate framewise phasor data to be loaded in addition to the tracking data.
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